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Thank You for Choosing Ross

You've made a great choice. We expect you will be very happy with your purchase of Ross Technology.
Our mission is to:
1. Provide a Superior Customer Experience
« offer the best product quality and support
2. Make Cool Practical Technology
» develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and
empowers our employees. | hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to
us at solutions@rossvideo.com.

—D.‘g\ 2\35

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a
special group. Our employees truly care about doing a great job and delivering a high quality customer
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our
behavior:

1. We will always act in our customers’ best interest.

We will do our best to understand our customers’ requirements.
We will not ship crap.

We will be great to work with.

o b

We will do something extra for our customers, as an apology, when something big goes wrong and
it's our fault.

We will keep our promises.
We will treat the competition with respect.

We will cooperate with and help other friendly companies.

© ® N

We will go above and beyond in times of crisis. If there's no one to authorize the required action in
times of company or customer crisis - do what you know in your heart is right. (You may rent
helicopters if necessary.)
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and will be repaired without charge for materials or labor within this period. See the “Warranty and Repair
Policy” section in this manual for details.

Environmental Information

The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health
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Introduction

In This Chapter

This chapter contains the following sections:
*  Overview
* Functional Block Diagram
» User Interfaces

¢ Documentation Terms and Conventions

A Word of Thanks

Congratulations on choosing an openGear VRC-100 VANC Receiver. Thank you for joining the
group of worldwide satisfied Ross Video customers!

Should you have a question pertaining to the installation or operation of your VRC-100, please
contact us at the numbers listed on the back cover of this manual. Our technical support staff is
always available for consultation, training, or service.
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Overview

The VRC-100 is a SMPTE 292 VANC receiver card which decodes known VANC data and
metadata and overlays the results on the video. It converts difficult to understand metadata to
comprehendible English and presents it as an overlay on the video that carries it. The VRC-100
may be customized to best suit your application. Decode just the metadata of interest and display
it how you want it and where you want it on the screen. It has a large library of known metadata
types from which to choose. The card supports up to eight overlay screens controlled by GPIO or
a PC over a LAN allowing for a fast switch from one set of metadata to another. You also get
alarms on the loss of metadata which can be on-screen, via GPIO or over the LAN.

If you work with SMPTE 292 video, this is the product that will let you know what data and
metadata it contains and whether or not it is correct. The VRC-100 provides a number of
innovative tools to simplify your workflow.

Features

The following features make the VRC-100 the solution of choice for monitoring the VANC:

*  SMPTE 292 input on a 750ohm BNC jack located on the rear module
e SMPTE 292 output with overlay for connection to a display

* Provides a DID/SDID map of the VANC space showing what metadata is being carried
and where

* Decoding of many important metadata formats so that you will not only be able to tell
what is present but also if it is correct

* Control over the metadata that is displayed, so that you can quickly switch between
views. This is important if you want to monitor more data than will fit on a single screen,
or if you monitor for different data on different signals.

* Automatic timed sequencing of different screens of data or control by GPIO (switches)
* Alarms to alert you when critical metadata in not present in your signal

* Matching of a set of stored configuration against the incoming audio metadata. Any
differences are highlighted in red for easy identification.

» Configuration of the card can be saved to the PC and restored at any time. This includes
switching from one configuration to another and loading different cards with the same
configuration

*  GPIO logic-level inputs and outputs for compatibility with a broad range of control and
monitoring equipment

* Displays all the DID/SDID VANC packets in a map format and will decode and display
the following data or metadata:

»  CEA-708 caption streams; DTVCC, 608 embedded and XDS embedded streams
»  Active Format Descriptors (AFD)
> Audio Metadata
»  Broadcast Flag
»  Time-code
> Logo Insertion triggers (CBS LIDIA V format)
»  Text Tags, packets carrying text identifiers
* Generic Data, detection of a packet by DID/SDID
* Non-volatile settings allow “set-and-forget” operation

* Rear modules provide video bypass

1-2 ¢ Introduction
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* Cards are hot-pluggable for ease of configuration and maintenance.
e Control and monitoring via DashBoard
 Fits in the openGear frames

* 5-year transferable warranty
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Functional Block Diagram

This section provides the functional block diagram that outlines the workflow of the VRC-100.
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User Interfaces

The VRC-100 includes the following user interface.

DashBoard Control System

DashBoard enables you to monitor and control openGear frames and cards from a computer.
DashBoard communicates with other cards in the frame through the Network Controller Card.
The DashBoard Control System software and manual are available for download from our
website.

For More Information on...
e the VRC-100 menus in DashBoard, refer to the chapter “Configuration” on page 4-1.
» using DashBoard, refer to the DashBoard User Manual.
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Documentation Terms and Conventions

The following terms and conventions are used throughout this manual.

Terms

The following terms are used:

“Board”, and “Card” refer to openGear terminal devices within openGear frames,
including all components and switches.

“DashBoard” refers to the DashBoard Control System.

“DFR-8300 series frame” refers to all version of the DFR-8310 series, DFR-8321 series,
and any available options unless otherwise noted.

“GPIO” refers to the DC signals used by one device to control another (General Purpose
Input-Output).

“Metadata” some of the VANC data that the VRC-100 monitors (such as closed
captioning) is “data essence”, not metadata. For convenience, this manual uses the term
“metadata” to refer to all VANC data types.

“openGear frame” refers to the DFR-8300 series and OG3-FR series that houses the
VRC-100 card.

“Operator” and “User” refer to the person who uses VRC-100.

“System” and “Video system” refer to the mix of interconnected production and terminal
equipment in your environment.

“VANC?” refers to the Vertical Ancillary Data space of a serial digital video signal, and is
defined by SMPTE 291M.

Conventions

The following conventions are used:

The “Operating Tips” and “Note” boxes are used throughout this manual to provide
additional user information.

1-6 ¢ Introduction
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Installation

In This Chapter

This chapter provides instructions for installing the VRC-100, installing the card into the frame,
cabling details, and updating the card software.

The following topics are discussed:
* Before You Begin
e Quick Start
* Installing the VRC-100
+ Cabling for the VRC-100
* Software Upgrades
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Before You Begin

Before proceeding with the instructions in this chapter, ensure that your openGear frame is
properly installed according to the instructions in its user manual.

Static Discharge

Throughout this chapter, please heed the following cautionary note:

A ESD Susceptibility — Static discharge can cause serious damage to sensitive

semiconductor devices. Avoid handling circuit boards in high static environments such as
carpeted areas and when synthetic fiber clothing is worn. Always exercise proper grounding
precautions when working on circuit boards and related equipment.

Unpacking

Unpack each VRC-100 you received from the shipping container and ensure that all items are
included. If any items are missing or damaged, contact your sales representative or Ross Video

directly.

2-2 « Installation VRC-100 User Manual (Iss. 04)



Quick Start

The purpose of the VRC-100 is to decode VANC data and overlay this information on the video.
To do this, you must:

1.
2,
3.

Install the VRC-100 into the openGear frame.
Configure the VRC-100 using the options in DashBoard.

Connect GPIOs to control what is overlaid on the screen.

Install the VRC-100

1. Connect the frame to your LAN. Refer to the DFR-8300 Series or OG3-FR Series User
Manual and the MFC-8300 Series or MFC-OG3 Series User Manual for details.
2. Install DashBoard on a computer connected to the LAN. The DashBoard Control
System software and user manual are available from the Ross Video website.
3. Install a rear module in the frame as described in the section “Installing a Rear
Module” on page 2-6.
4. Install a VRC-100 into the rear module as described in the section “Installing the
VRC-100” on page 2-7.
5. Connect a SMPTE 292 video signal to the SDI IN BNC on the rear module as described
in the section “Cabling for the VRC-100" on page 2-8.
6. Connect a SMPTE 292 compatible display to the SDI OUT BNC on the rear module.
Power on the frame.
Configure the VRC-100
1. Launch the DashBoard client on your computer.
* It should automatically find your frame within a minute or two.
* Expand the node for the frame that you installed the VRC-100 into. A list of cards
in the frame is now displayed in the Tree View.
* Double-click the node for the VRC-100 you wish to configure for encoding. A tab
for the card displays in the Device View of the DashBoard client.
2. To give the card a unique name:
* Select the Settings tab.
* Re-name the card.
3. To overlay the 708 captions and active format descriptor (AFD) on the video:
* Select the Captions and AFD boxes.
* Leave all other boxes cleared for now.
* Click Load to save these settings.
4. Configure the alarms for your card as follows:

* Select the Alarms tab.
* Itis recommended to enable the alarms for data types selected in the Settings tab.

* Enable the Loss of Video, AFD, Unknown Rear Module, Caption, and Bypass
alarms.
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Click Load to save these settings.

5. Configure the status block as follows:

Select the Status Block tab.
Select the Loss of Video, Captions, and AFD boxes.
Click Load to save these settings.

6. Select the caption data to decode as follows:

Select the Captions tab. There are four caption decoders available.
Set the first decoder to 708 Primary Language.

Set the second, third, and fourth to 708 Secondary, 608 CC1, and 608 CC3
respectively.

Click Load to save these settings.

7. Enable the AFD Description and AFD Bars feature:

Select the AFD Block tab.
Select the AFD Description and AFD Bars box.
Click Load to save these settings.

8. Create the first layout as follows:

Select the Layouts tab. This tab controls what will be overlaid on the screen at what
time. This example will create two layouts. The first will contain the 708 primary
language captions and the 608 CC1 captions. The second layout will contain the
status indicators and the AFD information.

At the top of the screen select Layout 1 from the Layout menu.

For the first Layout Item, select Caption Decode 1 which - in the previous step -
you set to 708 Primary Language.

Set the row to 1 and the column to 1 for this item.

For the next Layout Item, select Caption Decode 3 and row 12 column 1.
Set the other Layout Items to None.

Click Load to save this layout.

9. To create a second layout:

Select Layout 2 in the Layout menu.
For the first Layout Item, select Status Block and position it in row 1 column 1.
For the second Layout Item, select AFD and position it in row 23 column 1.

Click Load button to save this layout.

10. Select the layout(s) which are overlaid on the video when on GPIO switches are active:

Select the Default Screen tab.

A box on a layout causes that layout to be overlaid. Checking more than one layout
causes the overlay to sequence between layouts with a delay in seconds set by the
Display Time parameter.

Select the DID/SDID map then click Load. The video will be overlaid with a map
showing you the contents of the VANC.

You can then repeat this procedure selecting either Layout 1 or Layout 2 for display.
You will see the results on the monitor connected to the output of the VRC-100
card. If you select all three at once the overlay will sequence through each and
repeat.
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You have now successfully displayed VANC data. It is suggested that you try building and
displaying different screens of data to become familiar with the controls. Once you have become
familiar with creating layouts, you may wish to use GPIOs to control the layout that is displayed.
GPIOs control which layout is overlaid removing the necessity of having DashBoard running.

Connecting GPIOs

GPIOs serve two purposes: as inputs, they control what is overlaid on the video; as outputs, they
indicate the state of alarms. By default, all eight are configured as inputs; you can change these
assignments using one of the menus.

1. Connect a switch between GPIO 1 and GROUND. Refer to the section “Cabling for
the VRC-100" on page 2-8 for cabling details.

2. Select the GPIO Direction tab. The settings in this tab control whether the GPIO is used
as an input to control layouts or as an output to signal alarm conditions.

* Set GPIO1 to GP104 to inputs.
¢ Set GPIOS to GPIOS to outputs.
* Click Load to save these settings.

3. Select the GPIO Output Mapping tab. GPIO5 to GPIO8 will be present on this screen
because they were set to outputs in the previous step. These GPIOs will follow the
presence of their respective signals and can be used to trigger external alarms.

* Select Video Status from the GPIOS pull down list.
* Select Captions from the GPIO6 pull down list.

e Select AFD from the GPIO7 pull down list.

» Set GPIOS to None.

* Click Load to make the change.

4. Control the layout on GPIO as follows:

* Select the GPIO Menu Mapping tab. GPIO1 to GPIO4 will be present on this
screen.

e Set GPIOI1 to Layout 1.
¢ Set the other GPIO fields to None.

* Click Load to save the settings. When the switch connected to GPIO1 is open, the
default layout (as set on the Default Screen tab) is displayed. When the switch is
closed, layout 1 is displayed.

You have now successfully created layouts and controlled them with GPIOs. It is suggested that
you experiment with layouts and GPIO control until you have the information that you want
presented in the way that best suits your needs. DashBoard is no longer necessary for routine
operation because the screen overlays are controlled by the GP1Os. The chapter “Configuration”
on page 4-1 provides details on the tabs used to setup the card for operation. It may be used as a
reference and a guide to understanding the information that can be displayed and its meaning.
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Installing the VRC-100

This section outlines how to install a rear module and card in a openGear frame. Refer to the
section “Cabling for the VRC-100" on page 2-8 for cabling details.

Rear Modules

When installing the VRC-100:

*  DFR-8310 series frames — The VRC-100 requires the MDL-R10 Full Rear Module.
The VRC-100 is not compatible with the DFR-8310-BNC frames.

*  DFR-8321 series and OG3-FR series frames — The VRC-100 requires the MDL-R20
Full Rear Module.

Installing a Rear Module

If the Rear Module is installed, proceed to the section “Installing the VRC-100" on page 2-7.

To install a rear module in your openGear frame
1. Locate the card frame slots on the rear of the frame.
2. Remove the Blank Plate from the slot you have chosen for the VRC-100 installation.

3. Install the bottom of the Rear Module in the Module Seating Slot at the base of the
frame’s back plane. (Figure 2.1)

Screw Hole

Module Seating Slots
Figure 2.1 Rear Module Installation in an OG3-FR Series Frame (VRC-100 not shown)

4. Align the top hole of the Rear Module with the screw on the top-edge of the frame back
plane.

5. Using a Phillips screwdriver and the supplied screw, fasten the Rear Module to the back
plane of the frame. Do not over tighten.

6. Ensure proper frame cooling and ventilation by having all rear frame slots covered with
Rear Modules or Blank Plates.
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Installing the VRC-100

Use the following procedure to install the VRC-100 in a openGear frame:

1. Locate the Rear Module you installed in the procedure “Installing a Rear Module” on

page 2-6.
aution — Heat and power distribution requirements within a frame may dictate specific slo
Caut Heat and distribut ts within a fi dictat fic slot
placements of cards. Cards with many heat-producing components should be arranged to

avoid areas of excess heat build-up, particularly in frames using convectional cooling.

2. Hold the VRC-100 by the edges and carefully align the card-edges with the slots in the
frame.

Ensure that you are installing the card in an odd-numbered slot.

4. Fully insert the card into the frame until the rear connection plus is properly seated in the
Rear Module.

5. Verify whether your rear module label is self-adhesive by checking the back of the label
for a thin wax sheet. You must remove this wax sheet before affixing the label.

6. Affix the supplied rear module label to the BNC area of the Rear Module.
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Cabling for the VRC-100

This section provides information for connecting cables to an installed Rear Module on the
openGear frames. Connect the input and output cables according to the following sections. It is
not necessary to terminate unused outputs.

Rear Module Cabling

This section provides cabling diagrams for the rear modules. The type of rear module depends on
the frame the card is installed in.

DFR-8310 Series Frames

Each MDL-R10 Full Rear Module accommodates one card which must be in an odd-numbered
slot (3, 5, 7 etc.). The MDL-R10 provides one 292M input, two video outputs, a monitoring
output, and relay-isolated GPIO outputs. (Figure 2.2)

DFR-8321 Series and OG3-FR Series Frames

Each MDL-R20 Full Rear Module accommodates one card which must be in an odd-numbered
slot (3, 5, 7 etc.). The MDL-R20 provides one 292M input, two video outputs, a monitoring
output, and relay-isolated GPIO outputs. (Figure 2.3)

) %)
HD-SDI HD-SDI
HD-SDI In ° @ MON Out HD-SDI In ° l@l MON Out
2 2
@ Not connected
4

HD-SDI 3 HD-SDI 3
Out1 GFIOs Out 1 B ||cpios
1]
1]
1]
Not connected > HD-SDI Not connected W HD-SDI
Out 2 Out 2

Figure 2.2 Cabling for the MDL-R10 Rear Module Figure 2.3 Cabling for the MDL-R20 Rear Module

Connections Overview

This section briefly outlines the types of connections available on the rear modules.

292M In — BNC 1

BNC 1 accepts a 292M serial digital video signal. The VRC-100 requires this input in all cases.
The input signal is internally terminated in 75Sohms when the VRC-100 is installed.

HD-SDI Out 1 — BNC 3

BNC 3 carries the output of the VRC-100, with metadata status displayed on-screen. When the
VRC-100 card is removed from its slot or the bypass switch is activated, the rear module
bypasses BNC 1 to BNC 3 directly.
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HD-SDI Monitor Qut — BNC 2

BNC 2 carries an unswitched copy of the same signal that is output on BNC 3. When the
VRC-100 card is removed from its slot or the card is in bypass, this output is not driven.

HD-SDI OUT 2 — (BNC 5 or BNC 6)

BNC 5 (or BNC 6 on the MDL-R10) carries a second output from the VRC-100. The overlay
ability on BNC 3 and BNC 5 (6) is programmable under the Settings tab in DashBoard.
VRC-100 cards with serial numbers less than 107469 do not have this output.

GPIOs

Eight bi-directional, logic-level GPIOs are available. Refer to Figure 2.4 for pinouts on the
MDL-R10 and Figure 2.5 for pinouts on the MDL-R20.

ANWRNON®E
DONOUBRWN=

Figure 2.4 GPIO Pinouts for the MDL-R10 Figure 2.5 GPIO Pinouts for the MDL-R20
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Software Upgrades

This section provides instructions for upgrading the software for your VRC-100 using the
DashBoard Control System.

To upgrade the software on a VRC-100
1. Contact Ross Technical Support for the latest software version file.
2. Launch the DashBoard client on your computer.

3. Display a tab for the card you wish to upgrade by double-clicking its status indicator in
the Basic Tree View.

From the Device tab, click Upload to display the Select File for upload dialog box.
Navigate to the *.bin upload file you wish to upload.
Click Open and follow the on-screen instructions.

Click Finish to start the upgrade.

@ N o o s

Monitor the upgrade.

* A Upload Status dialog enables you to monitor the upgrade process.

* The card reboots automatically once the file is uploaded. The card is temporarily
taken off-line.

» The reboot process is complete once the status indicators for the Card State and
Connection return to their previous status.

\/ Operating Tip — If you are running DashBoard version 2.3.0 or lower, you must
click Reboot in the Device tab to complete the upgrade process.

Troubleshooting
If you encounter problems when upgrading your card software, verify the following:

» Ethernet cable is properly connected if you are uploading the file via a network
connection.

» The file you are attempting to load is a *.bin file that is for the card you are upgrading.
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User Controls

In This Chapter

This chapter provides a general overview of the user controls available on the VRC-100.
The following topics are discussed:

¢ Card Overview

* Control and Monitoring Features
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Card Overview

This section provides a general overview of the VRC-100 card components.

02| (il

g | M

Figure 3.1 VRC-100 — Components

‘ 1) Bypass Switch (SW1) 2) Menu Switch (SW2) 3) Reset Switch (SW3)

1. Bypass Switch (SW1)

If the VRC-100 is installed in a rear module that has a bypass relay, this two-position push-button
is used to control the relay.

*  When the push-button is in the IN position, the VRC-100 is in the video signal path.
* Pressing it once moves the switch to the OUT position and bypasses the VRC-100.
* Pressing it again restores the VRC-100 to its active state.
2. Menu Switch (SW2)
This switch is not implemented on the VRC-100.
3. Reset Switch (SW3)

This button is used for rebooting the card. Refer to the section “Reset Button” on page 6-2 for
details on using this button.

For More Information on...

+ the LEDs available on the card-edge, refer to the section “Control and Monitoring
Features” on page 3-3.
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Control and Monitoring Features

This section provides information on the card-edge LEDs for the VRC-100. Refer to Figure 3.2

for the location of the LEDs.

POWER LED (DS1) —

BYPASS LED (DS2) —
) —
)

Bypass Switch (SW1
PGM VID IN LED (DS3

PGM VID OUT LED (DS4)
DS5 LED

VID 2 SDI OUT LED (DS6)

o T

P<— Menu Switch (SW2)

VID IN LED (DS7)

CAPTIONING LED (DS8)
AFD LED (DS9)

BT

[j————— AUDIO METADATA LED (DS10)
f————— BROADCAST FLAG LED (DS11)
[f——— TIMECODE LED (DS12)

’h <4+—— Reset Button (SW3)

Figure 3.2 VRC-100 Card-edge Controls

Status and Selection LEDs on the VRC-100

The front-edge of the VRC-100 has LED indicators for communication activity. Basic LED
displays and descriptions are provided in Table 3.1.

Table 3.1 LEDs on the VRC-100

(DS1) Orange

LED Color Display and Description

When lit green, this LED indicates the card is operating with a

Green .
valid input.

. When flashing green, this LED indicates the bootloader is

Flashing Green .

waiting for a software upload.
POWER

When lit orange, this LED indicates this is a warning about a
signal or configuration error.

When lit red, this LED indicates that the card is not operational.

Red This will occur if, for example, there is no video input.
Off When off, this LED indicates there is no power to the card.
Red When lit red, this LED indicates the card is in bypass mode.
BYPASS ; — - X .
(DS2) Off When off, this LED indicates the card is in the video path and is

capable of inserting data.
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Table 3.1 LEDs on the VRC-100

LED Color Display and Description
When lit green, this LED indicates the Program Video input is
Green .
present and valid.
PGM VID IN ; ; P T .
(DS3) When lit red, this LED indicates that no valid input is present.
Red Ensure that the input cable is connected properly to the rear
module.
When lit green, this LED indicates the Program Video output
Green T Lo
PGM VID serializer is locked to a valid input.
OUT (DS4) Red When lit red, this LED indicates there is hardware fault on the
card.
DS5 This LED is not implemented.
When lit green, this LED indicates that the video 2 output
Gireen ializer is locked to a valid input
VID 2 SDI S€r1al1zer 1S 10CKE put.
OuUT (DS6) Red When lit red, this LED indicates that there is a hardware fault on
the card.
Green When lit green, this LED indicates that no video errors are
occurring.
VID IN (DS7) X X . . . .
Red When lit red, this LED indicates that the video input is missing
or invalid.
Green When lit green, this LED indicates that VANC captioning is
CAPTIONING present.
(DS8) Red When lit red, this LED indicates that the VANC captioning data
is missing.
Green When lit green, this LED indicates that VANC AFD is present.
AFD (DS9) Red When lit red, this LED indicates that the VANC AFD metadata
is missing.
Green When lit green, this LED indicates that the audio metadata is
AUDIO present.
METADATA When lit red, this LED indi that the VANC audi tadat
(DS10) Red When lit red, this indicates that the audio metadata
is missing.
Green When lit green, this LED indicates that the VANC Broadcast
BROADCAST Flag is present.
FLAG(DS11) Red When lit red, this LED indicates that the VANC Broadcast Flag
is missing.
Green When lit green, this LED indicates that the VANC timecode is
TIMECODE present.
(DS12) Red When lit red, this LED indicates that the VANC timecode is

missing.

Note — The DS7-DS12 LEDs are conditioned by the selections made in the Alarm
Enable and Settings tabs in DashBoard. Each of these LEDs will only turn red if its
corresponding Alarm Enable bit is set.
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Configuration

In This Chapter

This chapter explains how to use the user interface to set up the VRC-100. This discussion is
based on the use of DashBoard through a network connection. The order of sections in this
chapter follows the workflow required to setup the VRC-100 for operation. It is recommended
that you proceed through the following sections in order to achieve the best possible
understanding of the product.

The following topics are discussed:
* General Settings
* Selecting the Metadata to Monitor
» Setting Timeouts for Detecting Loss of Metadata
» Specifying How to Display the Metadata
* Setting GPIO Inputs and Outputs
e Defining Screen Layouts

*  Monitoring
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General Settings

This section provides a summary of the initial tasks you may wish to perform before configuring
your card for monitoring VANC data. Before proceeding to any of the other sections, please
ensure that these settings are correct, as they will have an effect on the operation of the other
functions.

To configure the general settings

1.
2,

Select the Settings tab.

Type a unique name for your card in the Card ID field. This is especially useful if you
have more than one VRC-100 in a frame. If this field is blank, the name is “VRC-100".

Specify the overlay of the two outputs on the card using the Program 1 and Program 2
menus. Program 1 refers to BNC 3 and Program 2 refers to BNC 5 (or BNC 6 on the
MDL-R10). If overlay is selected the VRC-100 overlays data onto the output video,
overlay off lets the video pass unaltered.

Notice — VRC-100 cards with serial numbers less than 107469 do not have the
HD/SD-SDI Output 2 on BNC 4.

4,

Use the First Capture Line and the Last Capture Line fields to specify the range of
lines that the card processes when looking for VANC metadata. Normally, you can leave
these set to include the complete range of VANC lines (1-20 for 1080i and 1-25 for
720p). However, you may wish to reduce the range to focus on the data in one specific
line, for example.

You can save the Configuration of the card to a file on a PC by clicking Save.

The Factory Defaults Reset button clears all configuration settings and restores the
settings to the values they had when shipped from the factory.
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Selecting the Metadata to Monitor

This section briefly summarizes how to configure the VRC-100 to monitor data.

Selecting the Metadata to Monitor

The Settings tab enables you to select the types of metadata that you wish to monitor. Metadata
monitoring is enabled by selecting the box beside the metadata type. It is important that you
enable each of the metadata services that you wish to monitor in the Settings tab before selecting
them in other menus that make use of their data. Otherwise, the services will be shown as missing
even when they are present.
To set the Metadata to monitor

1. Select the Settings tab.

2. Select the box for the data or metadata type to monitor from the provided list.

3. Click Load to apply the changes.

Setting the Address of the Metadata

By default these will be set to the addresses normally used for the data types. The addresses
should only be changed if required and may be restored by pressing the Defaults button.
To set up the addresses of the metadata

1. Select the DID/SDID Setup tab.

2. Configure the addresses using the options in the DID and SDID columns.
3. Click Load to apply the changes.
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Setting Timeouts for Detecting Loss of Metadata

The default values are normally appropriate but may be changed by selecting a new value from
the pull down list in the Metadata Timeouts tab.
To setup the timeout used to debounce the loss of metadata

1. Select the Metadata Timeouts tab.

2. Seclect a timeout value from the required data type you are monitoring.

3. Click Load to apply the changes.

Selecting the Alarm Conditions

Notice — The Caption alarm is triggered by a one-second loss of caption data.
However, the displayed caption text is cleared after ten seconds pass without any
new caption text being presented, whether or not caption data is present.

The Alarm tab, located in the status area of the Device View in DashBoard, reports the status of
metadata services. Any alarm in the red state causes the card state to be red. Or, viewed another
way, on seeing that the card state is red, you should check which VANC data is missing on the
Alarms tab. However, which services are monitored is determined by the options configured in
the Alarms tab.

To enable the alarms to display in DashBoard

1. Select the Alarms tab.

2. For each metadata type you selected in the Settings tab, enable the corresponding alarm
in the Alarms tab.

Notice — It is important that you enable each of the metadata services that you
wish to monitor in the Settings menu before enabling alarms for them in this menu.
Otherwise, the services will be shown as missing even when they are present.
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Specifying How to Display the Metadata

In DashBoard, the VRC-100 has settings that allow you to control the display of the metadata on
the screen. Each type of metadata has a tab that allows you to select how much detail is displayed.
This section provides an overview on how to use the options in the tabs.

Status Block Display Options

Use the options in the Status Block tab to control the appearance of the status block metadata
summary screen. Each box controls whether the status block will contain a presence indicator for
the corresponding metadata type. On the Video tab this will be a round indicator colored green if
the metadata is present or red if it is not. It is important that you enable each of the metadata
services that you wish to monitor in the Settings tab before enabling alarms for them in this
menu. Otherwise, the services will be shown as missing even when they are present.

Active Format Descriptor Display Options

You will use the AFD Block tab to control the appearance of the Active Format Descriptor (AFD)
when overlaid on video. The display will be one or two lines of text depending on the boxes that
are selected. The following options are available.

AFD Description

Selecting this box determines whether the name is displayed. When not set, only a short form is
displayed. When set, the short form is followed by a long description. A typical AFD description
would look like:

AFD 16:9 8 Full frame 16:9 image preferred coding
“AFD 16:9 8" is the short form, where 16: 9 is the aspect ratio and 8 is the AFD code. The rest

of the line is the long description of what code 8 means.

AFD Bars

This box controls whether a second line displays the bar information. This will be in the form:
Top Bar 25 Bottom Bar 746

It will display the top and bottom line numbers for letterbox images and the left and right pixel
numbers for pillar bar images.

Use SMPTE descriptions

This box allows the user to select SMPTE or common text descriptions.

GPIO Trigger

Each GPIO Trigger menu allows the user to set output GPIOs to trigger on specific AFD codes.

Logo Logs Display Options

Use the options in the Logo Log tab to control what is displayed for logo insertion triggers. The
logo trigger log is an on-screen list of the last five logo insertion triggers. Currently the CBS
LIDIA 'V trigger format is supported.
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The logo triggers overlay is a full width overlay of variable length. The first two lines are the last
or currently active trigger. The next one to five lines are the history of the previous triggers. The
Full Text Description box affects the way the history lines are displayed, and allows you to
switch between the full text and the abbreviations. A typical logo trigger overlay looks like:

14:23:10-Active Fade= 5 Fade=5 0,0 s=0
Solid Logo

13:29:00-13:29:10 SL F=5 F=5 0,0 s=0
13:10:30-13:10:45 SL,ST+T F=5 F=5 0,0 s=0

There are three possible logos called “Logo”, “Time and Temp” and “Text”; in short form, these
are L, T+T and T. Each of these can be displayed on a solid black or a transparent background
which are displayed as Solid or Trans in their long form or S and T in their short form. The
bottom history line therefore shows that between 13:10:30 and 13:10:45 there were both a solid
logo and a solid time and temp which faded in for 5 seconds and faded out for 5 seconds. The
logos were positioned at the default location (0,0) and were for service 0.

Local Time and Date Display Options

The VRC-100 allows you to include a display of the local time and date in the video overlay. The
Time tab controls the source of time and date and how it is used. Automatic time setting is
convenient, provided you have network access to an NTP (Network Time Protocol) server.

1. Select the Time tab.
2. Select Network Time.

3. Specify your time offset from Universal Time (UTC), as a positive or negative number
of hours and minutes. For example, the area of North America where Pacific time is
observed is 8 hours west of longitude 0; the settings would be UTC Offset: HH = -8,
and MM = 0. Note that UTC is also known as GMT (Greenwich Mean Time).

4. Enable or disable DST (Daylight Savings Time) as appropriate, and click Accept.

In order to use network time, you also need to ensure that the network card in the
openGear frame has been configured to acquire time from an NTP server. Refer to the
MFC-8300 Series or MFC-OG3 Series User Manual for details.

6. If you do not have access to an NTP server, you can enter the time and date directly on
the Time menu, select Manual and click Accept.

Caption Decode Display Options

The Captions tab is used to control the appearance of the Captions when overlaid on video. There
are four caption windows which can be placed on the screen. Each window may contain one of
the captioning text streams as defined in CEA 708.

First language captions are normally in the 708 Primary Language and in 608 CC1. The second
language captions are normally in the 708 Secondary Language and 608 CC3.

Notice — To be compliant with FCC caption rules, a signal must contain both 708
and 608 captions. The VRC-100 allows you to check that both are present.

Audio Metadata Monitoring Options

Audio metadata monitoring is controlled by the Audio Metadata Monitoring tab which has four
sub-tabs as shown in the following two screen captures. The card will store up to five program
configurations which it matches captured audio metadata against.

4-6 * Configuration VRC-100 User Manual (Iss. 04)



Audio Metadata Monitoring Sub-tab

The Current Program Config pull-down menu selects which of the five configurations to
modify. Note that all five buffers are monitored simultaneously.

The Program Config selects which of the program configurations this set of data will be used to
match against.

\/ Operating Tip — Ensure that the Current Program Config values match before
copying and pasting between Program Numbers.

The Encode Method and Frame Rate are parameters and can be set to explicit, must match,
values or left as Don’t Care so that they will not be used in the match. Data which does not match
will be displayed in red on the overlay screen and will cause the audio metadata indicator to be
red.

The Load Defaults, Copy and Paste buttons can be used to lessen the burden of setting the
many audio metadata parameters. Copy allows you to copy the settings from one program and
Paste allows you to set them into a different program. You then only have to change the
parameters which are different between the two programs. Note that the Copy and Paste feature is
applicable for programs within a single configuration buffer only and not across different
configuration buffers.

The Apply Current Program Matches button is how you save your work. It is wise to save your
work often.

Program, XBS, and Flags Sub-tabs

Each program configuration has a number of programs and all parameters on the Program, XBS
and Flags sub-tabs must be set to their match values or to Don’t Care if no match is desired. The
Program number pull-down menu selects which program parameters are set. So, start with
Program 1 (BNC 3) and set the parameters and then do Program 2 (BNC 5 or 6) and so on until all
the required programs are set. Use Copy and Paste whenever possible to limit the number of
parameters to set.

Each parameter for the program must be set to a match value or to Don’t Care if no match is
desired.

Timecode Display Options

The VANC may include two types of timecode on three possible lines. Normally the first
timecode found anywhere in the VANC is the one displayed. If the Enable Timecode Filter box
is selected, then timecode will only be decoded from the line and field selected.

Selecting the Background Color

The Colors tab is used to control whether text is overlaid on a black background or a
semi-transparent background. Each of the metadata components has a box on this tab.

To specify a background
1. Select the Colors tab.
2. For each metadata type you are monitoring:

* Select a box to apply a black background for that metadata component text. This
option achieves the most legible display of the metadata information.
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» Ifthe box is cleared, the background will be semi-transparent. This option covers as
little of the underlying picture as possible.
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Setting GPIO Inputs and Outputs

GPIOs serve two purposes; as inputs, GPIOs select what is overlaid over the video. As outputs,
GPIOs act as alarms when a metadata is not present. The GPIO Direction tab is used to control
the direction of the eight GPIOs. Each GPIO input controls the display of one screen layout of
metadata. The contents of the layout are controlled by the Layout tab. An active GPIO causes the
layout associated with it to be displayed. GPIO outputs can be associated with alarms and their
state will then change with the state of the alarm.

GPIO outputs can be associated with alarms and their state will then change with the state of the
alarm. The mapping of alarms to GPIOs is discussed later.

The GPIO Menu Mapping tab allows GPIOs to control the display of screen layouts.

The GPIO Output Mapping tab controls the mapping of alarms to GPIOs. There will be one
GPIO alarm menu item for each GPIO configured for output. There is a delay built in to the
detection of loss of metadata. This influences the loss of metadata alarms.

The Default Screen tab controls which layouts will be overlaid on the video when none of the
GPIO switches are in use. Any selected layout will be part of a sequence of overlays. If no layouts
are selected, then no overlays will be present unless requested by a GPIO switch. GPIO switches
have priority over the default sequence and will immediately bring up the overlay associated with
the switch.

VRC-100 User Manual (Iss. 04) Configuration * 4-9



Defining S

Defin

creen Layouts

The purpose of the Layouts tab is to take metadata and combine then into screens. There are eight
possible layouts as selected by the Layout Menu pull-down. Each layout can contain up to four
Layout Items. These items are the metadata objects that you have configured as described earlier
in this manual.

Each layout item must be placed on the overlay screen. This is done by selecting a row and
column position for the information. There are three columns across the screen and 24 rows. Each
layout item has a size so not all possible screen position are allowed for all items. When working
with layouts it is recommended that you watch the overlay screen to make sure the screen is as
desired.

ing the Default Screen Layouts and Sequencing

The Default Screen tab controls which layouts will be overlaid on the video when none of the
GPIO switches are in use.

To define the default screen layouts and sequencing

1. Select the Default Screen tab.

2. Seclect which layout(s) will be part of a sequence of overlays. If no layouts are selected,
then no overlays will be present unless requested by a GPIO switch. Note that GPIO
switches have priority over the default sequence and will immediately bring up the
overlay associated with the switch.

3. If multiple layouts are selected, use the Display Time field to specify the length of time
in seconds that each overlay will remain on the screen.

4. Click Load to apply the new settings.

Controlling the Screen Layouts using GPIOs

The next step is to define which GPIO, if any, will control when a screen layout is overlaid on the
screen. The GPIO Menu Mapping tab allows GPIOs to control the display of screen layouts.
Note that only those GPIOs configured as inputs are displayed in the GPIO Menu Mapping tab.

The default layout is the one which is used when no GPIOs are active. The lower the number of
the GPIO, the higher its priority as an input. So, if both GPIO1 and GPIO2 are active, then the
screen associated with GPIOI is displayed.

Notice — if the VRC-100 is using a rear module that has no GPIOs and only
provides relay-contact outputs, this menu will not appear and all GPIOs will be set to
output.

To use GPIOs to control the screen layouts

1. Select the GPIO Menu Mapping tab. On this tab there is one GPIO layout menu for
each GPIO configured as an input (up to eight).

2. Assign layouts to the available GPIO(s). This may be any layout, a DID/SDID Map or
no overlay.

3. Click Load to apply the new settings.
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Monitoring

This section provides a detailed explanation of the status tabs available when using DashBoard to
monitor the VRC-100.

Connecting Alarms to GPIOs

An alarm is generated when metadata or video is not present. The metadata service must be one
that is being monitored and the alarm for the metadata must be enabled as described earlier in this
document. The GPIO Output Mapping tab controls the mapping of alarms to configured
GPIOs. There will be one GPIO alarm pull-down for each GPIO configured for output, as
described earlier in this manual. Once a GPIO is associated to a type of metadata, its output will
track the presence of that metadata. The polarity can be changed by selecting the Active Low
box. With the box selected, a high level on the GPIO indicates the absence of the assigned signal,;
with the box cleared, a high level on the GPIO indicates its presence.

There is a delay built in to the detection of loss of metadata. This debounces the loss of metadata
alarms. Different types of metadata have different debounce times, as discussed in a previous
section.

Monitoring using DashBoard

The Status tabs provide read-only information such as software revision issue, signal status, and
power consumption of the VRC-100.

Product Status

The Product tab has information about the VRC-100 which will be helpful to a Ross Video
technician when there are questions about the operation of the unit. This tab summarizes the
read-only information, such as board revision, serial number, and rear module type.

Operating Status
The Status tab contains information about the operation of the unit.

* The Active/Bypass field reports either Active or Bypass. When active, the card can
overlay the metadata information over the video. In bypass, the card input is connected
directly to the card output.

* The Current Video field reports either the current video at the input connector or
“None”.

* The GPIO fields report what each of the GPIOs is currently being used for (displays
High/Low for assigned GPIOs). The term “Not Assigned” means that the GPIO is not
assigned to any function.

Alarms Status

The Alarms tab reports the current state of all the signals that can cause alarms. There is an alarm
summary that includes indication for Loss of Video, Unknown Rear Module and Bypass, as well
as individual alarms listed. The individual alarms are reported as:

* A green status indicates no alarm and red indicates an alarm state.

* Ared alarm status for any of the monitored VANC data will cause a red alarm for the card
and the frame. When a frame alarm occurs, you should first check which card and then
which event caused the alarm.
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It is important that you enable each of the metadata services that you wish to monitor in the
Settings tab before enabling alarms for them in this tab. Otherwise, the services will be shown as
missing even when they are present.

Last Alarm Log

If the alarm for a metadata type is enabled in the Alarms tab, the associated field in the Last
Alarm Log tab reports when that metadata last occurred. It has the same items as the Alarms
status tab but it includes time stamp information when the alarm occurred. There is no “Card
Status” item, but it has a Clear button to reset the time stamp to zero (0).
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Specifications

In This Chapter

This chapter provides the technical specification information for the VRC-100. Note that
technical specifications are subject to change without notice.

The following topics are discussed:

» Technical Specifications
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Technical Specifications

This section provides the technical specifications for the VRC-100.

Table 5.1 VRC-100 Technical Specifications

Category Parameter Specification
Number of Inputs
Input Signal Standard SMPTE 292 HD-SDI, 1080i or 720p
Accommodated
SDI Inputs Impedance 750hm terminating in Active mode
Loop-through to Video Output in Bypass mode
Equalization >100m of Belden 1694A cable
Return Loss >13dB to 1.485GHz
3 SMPTE 292 outputs with optionally overlaid
Number of Outputs on-screen display
1 output is bypass-protected
Impedance
SDI Outputs Return Loss >10dB to 1.485GHz
Signal Level 800mV £10%
DC Offset
Rise & Fall Time (20-80%) 120ps typical
Overshoot
GPIO Outputs gﬁg}g: and Type of Inputs or 8 logic inputs or outputs (3.3v) plus ground.
Power Maximum Power Consumption
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Service Information

In This Chapter

This chapter contains the following sections:

Troubleshooting Checklist
Warranty and Repair Policy

VRC-100 User Manual (Iss. 04) Service Information ¢ 6—1



Troubleshooting Checklist

Routine maintenance to this openGear product is not required. In the event of problems with your
VRC-100, the following basic troubleshooting checklist may help identify the source of the
problem. If the frame still does not appear to be working properly after checking all possible
causes, please contact your openGear products distributor, or the Technical Support department at
the numbers listed under the “Contact Us” section.

1.

Visual Review — Performing a quick visual check may reveal many problems, such as
connectors not properly seated or loose cables. Check the card, the frame, and any
associated peripheral equipment for signs of trouble.

Power Check — Check the power indicator LED on the distribution frame front panel
for the presence of power. If the power LED is not illuminated, verify that the power
cable is connected to a power source and that power is available at the power main.
Confirm that the power supplies are fully seated in their slots. If the power LED is still
not illuminated, replace the power supply with one that is verified to work.

Re-seat the Card in the Frame — Eject the card and re-insert it into the frame.

Check Control Settings — Refer to the Installation and User Controls sections of this
manual to verify all user-adjustable component settings

Input Signal Status — Verify that source equipment is operating correctly and that a
valid signal is being supplied.

Output Signal Path — Verify that destination equipment is operating correctly and
receiving a valid signal.

Unit Exchange — Exchanging a suspect unit with a unit that is known to be working
correctly is an efficient method for localizing problems to individual units.

Reset Button

In the unlikely event of a complete card failure, you may be instructed by a Ross Technical
Support specialist to perform a complete software reload on the VRC-100.

To reload the software on the VRC-100

1.
2,
3.

Press and hold the Menu switch.
While holding the Menu switch, press the Reset button in.
Release the Reset button and then the Menu switch.

* The POWER LED will flash green while the card is waiting for a new software
load.

e Ifa new software load is not sent to the card within 60 seconds, the card will
attempt to restart with its last operational software load.

¢ Software loads can be sent to the VRC-100 via the connection on the rear of the
frame.
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Warranty and Repair Policy

The VRC-100 is warranted to be free of any defect with respect to performance, quality,
reliability, and workmanship for a period of FIVE (5) years from the date of shipment from our
factory. In the event that your VRC-100 proves to be defective in any way during this warranty
period, Ross Video Limited reserves the right to repair or replace this piece of equipment with a
unit of equal or superior performance characteristics.

Should you find that this VRC-100 has failed after your warranty period has expired, we will
repair your defective product should suitable replacement components be available. You, the
owner, will bear any labor and/or part costs incurred in the repair or refurbishment of said
equipment beyond the FIVE (5) year warranty period.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or
consequential damages (including loss of profits) incurred by the use of this product. Implied
warranties are expressly limited to the duration of this warranty.

This VRC-100 User Manual provides all pertinent information for the safe installation and
operation of your openGear Product. Ross Video policy dictates that all repairs to the VRC-100
are to be conducted only by an authorized Ross Video Limited factory representative. Therefore,
any unauthorized attempt to repair this product, by anyone other than an authorized Ross Video
Limited factory representative, will automatically void the warranty. Please contact Ross Video
Technical Support for more information.

In Case of Problems

Should any problem arise with your VRC-100, please contact the Ross Video Technical Support
Department. (Contact information is supplied at the end of this publication.)

A Return Material Authorization number (RMA) will be issued to you, as well as specific
shipping instructions, should you wish our factory to repair your VRC-100. If required, a
temporary replacement frame will be made available at a nominal charge. Any shipping costs
incurred will be the responsibility of you, the customer. All products shipped to you from Ross
Video Limited will be shipped collect.

The Ross Video Technical Support Department will continue to provide advice on any product
manufactured by Ross Video Limited, beyond the warranty period without charge, for the life of
the equipment.
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Contact Us

Contact our friendly and professional support representatives for the following:

+ Name and address of your local dealer

» Product information and pricing
» Technical support

» Upcoming trade show information

. Telephone:
Tse’Chn:)cr?I After Hours Emergency:
u

PP Email:
Telephone:
General Fax:
Information Email:
Website:

Visit Us

Visit our website for:

+ Company information and news

+1613 » 652 + 4886
+1 613 » 349 - 0006
techsupport@rossvideo.com

+1 613 « 652 « 4886
+1 613 « 652 * 4425
solutions@rossvideo.com
http://www.rossvideo.com

» Related products and full product lines

* Online catalog

* Testimonials
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